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A. Ricerche in Alma: vedi esempi 
1- Ricerca “Tuti i titoli”: ricerca su tutto il Discovery di Alma sia quelli con copie fisiche che quelli senza copie 

fisiche collegate (ex record delle civiche) 

 

2- Ricerca “Titoli fisici”: Ricerca su tutto il Discovery di Alma delle monografie con copie fisiche collegate 
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3- Ricerca “Copie fisiche”: Ricerca su tutto il Discovery di Alma le copie possedute con il titolo cercato 
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Ogni ricerca può essere fatta all’interno della ”Istituzione” o della “Community”. 

ATTENZIONE: Se troviamo il titolo in formato elettronico prima di procedere all’ordine occorre editare il record per 

copiarlo in locale e trasformarlo in Unimarc 

 

B. Fornitori 
I fornitori sono come in precedenza in Aleph gestiti a livello centrale dal CSSBA. 

Sono attualmente presenti in Alma 53 fornitori attivi e 397 inattivi. 

Per vedere i fornitori eseguire una ricerca semplice per Fornitore e scorrere la lista, filtrandola per status, oppure 

ricercare per nome o codice (o meglio Tutto) il fornitore desiderato. 

Esempio: ricerca per Tutto=Bozzi 

Per vedere i dettagli del fornitore cliccare sul menu Visualizza. La scheda fornitore viene visualizzata sulla pagina 

Sommario, contenente il codice, il nome, la valuta di fatturazione, le unità d’ordine per cui il fornitore è disponibile, il 

tipo di fornitore.  

 

Cliccando sui …  di fianco alla sezione Account si visualizzano i dettagli dell’account fornitore: sconto praticato, 

metodo di pagamento, tempi di consegna e sollecito. 

Le altre finestre mostrano: 

Informazioni di contatto: indirizzi, mail ecc. 

Informazioni EDI: solo nel caso sia stato attivato l’EDI per ordini o fatture 

Fatture: le fatture collegate al fornitore. NB: attualmente si vedono solo le fatture posteriori alla migrazione, anche 

se in realtà, da un controllo incrociato in una ricerca per fondo, tutte sono migrate. 

Linee d’ordine: chiuse e aperte 

Comunicazioni: lo storico dei messaggi inviati al fornitore (ordini inviati manualmente, solleciti automatici) 

Allegati: l’elenco dei messaggi in entrata e in uscita (ricevuti da/inviati a).Il testo dei messaggi è visualizzabile e 

scaricabile dal menu … Visualizza/Scarica (Es. YBP) 

Note: le note inserite sul fornitore 

Report e statistiche: un grafico riepilogativo dell’andamento del fornitore nell’anno precedente 
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Dall’elenco delle Linee d’ordine è possibile passare alla visualizzazione della singola linea d’ordine oppure al 

pacchetto di ordini che la contiene cliccando sul numero della linea d’ordine oppure sull’ordine 

 

Se si clicca invece su Edita si apre la linea d’ordine in editing 

NB: E’ importante sottolineare che ordini e solleciti vengono inviati automaticamente dal sistema all’indirizzo e-

mail del fornitore. Se il fornitore non ha un indirizzo e-mail valido, l’ordine NON viene inviato. 

 

 

C. Periodo fiscale, Fondi e Registri (Ledger) 

In Alma 2 importanti novità relative ai fondi: Periodo fiscale (Anno contabile) e Registro (General Ledger). 

In ogni periodo fiscale c’è di norma un solo ledger (registro). Il registro è un raggruppamento di fondi di un unico 

periodo fiscale. Teoricamente sarebbero possibili più ledger per periodo fiscale, ma abbiamo scelto di mantenere un 

registro unico per ciascun anno. 

1.Una ricerca generica  per fondo permette di  recuperare tutti i fondi (COAN) presenti in Alma.  

Inizialmente i risultati sono presentati già filtrati per status Attivo e Periodo fiscale 2018. Ci sono 99 fondi attivi 

appartenenti al periodo fiscale 2018, perché sono stati attribuiti al 2018 tutti i fondi che, pur costituiti in anni 

precedenti, avevano scadenza 2018. 
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NB.La prima cosa da fare, una volta a regime con le Acquisizioni, sarà controllare tutti i fondi attivi per ciascuna unità 

d’ordine, e disattivare quelli non più validi o con saldo disponibile insufficiente 

 

NB2.Un’altra raccomandazione è di concordare con gli amministrativi una forte limitazione dei fondi da utilizzare: p. 

es. la Biblio di Scienze sociali ha attualmente 46 fondi attivi (2017/2018), la Politecnica 30, ecc. 

 

2.Per vedere tutti i fondi, anche quelli inattivi o appartenenti a un diverso periodo fiscale, rimuovere i filtri applicati  

utilizzando il pulsante Pulisci tutto. Vengono presentati 1066 fondi, attivi e non, relativi ai diversi periodi fiscali. Se 

utilizziamo le faccette a sinistra si possono filtrare e trovare i soli fondi attivi e disponibili per una specifica unità 

d’ordine  

 

 

3.I fondi attivi per l’unità d’ordine Scuola umanistica sono 36, appartenenti a 2 diversi periodi fiscali. Di questi, uno è 

il registro (General Ledger) attualmente attivo, condiviso con tutte le altre strutture del Sistema Bibliotecario, 

mentre 35 sono i fondi (COAN) propriamente detti 
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4.Analisi dei dati di un fondo. 

I fondi visualizzati mostrano un breve riepilogo dei dati: 

Nome, codice, status (attivo/inattivo), tipo (Fondo/Registro), periodo fiscale, percorso, 

Saldo accreditato=Allocated balance (totale accrediti) 

Bilancio di spesa=Expenditure balance (totale spese, cioè fatture)  
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Saldo cassa=Cash balance (totale accrediti meno le spese, cioè le fatture) 

Saldo impegnato=Encumbered balance (totale impegni meno disimpegni, cioè ordini per cui è già stata registrata la 

fattura). Questo dà la situazione degli ordini effettuati, ma non ancora arrivati 

Saldo disponibile=Available balance (totale accrediti meno impegni attivi meno fatture) 

 

5.Per visualizzare i dettagli del fondo cliccare sul nome.  

Si apre in editing la pagina Sommario del fondo. 

 E’ possibile disattivare, visualizzare il grafico del fondo, aprire la sezione Regole per: 

-prolungare la validità del fondo, per esempio per pagare una fattura oltre la data di validità del fondo (Tolleranza 

spese fine periodo fiscale) o effettuare un nuovo ordine sul fondo (Tolelranza impegni fine periodo fiscale) 

-permettere uno sforamento a livello di impegni (in percentuale) o di spese (in valori assoluti) 

 

 

NB: un fondo può essere attivo, ma non utilizzabile a meno che non si aumenti la sua validità 

La seconda pagina, Transazioni, permette di vedere in dettaglio le linee di impegno, disimpegno, spesa. 

A differenza di Aleph, quando viene pagata una fattura la linea di impegno non si azzera, ma viene creata una 
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corrispondente linea di disimpegno, oltre alla linea per la spesa. 

 

In una linea di Impegno/Disimpegno cliccando sulla linea PO collegata si visualizza l’ordine; in una linea di spesa  si 

possono visualizzare la linea d’ordine o la linea di fattura 

Es. Linea d’ordine 

 

 

Es. Linea di spesa 
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Le altre due pagine della scheda Fondo “Note” e “Allegati” permettono di aggiungere o visualizzare note rilevanti al 

fondo, e di caricare documenti rilevanti per il fondo stesso 

6.Aggiungere un fondo 

E’ possibile aggiungere un nuovo fondo duplicando un fondo già esistente, oppure partendo dal General ledger-

>cliccare su Fondi->Aggiungi fondo. (Acquisitions->Fund and ledgers->). Tuttavia se si duplica un fondo alcuni 

parametri non sono modificabili, se si crea un nuovo fondo a partire dal Ledger si ha maggiore flessibilità. 

Per esempio il fondo BSSU – LETTERE INTEGRAZIONE – NUOVA P. BOZZI  (cod. UMA-123456) è stato creato a partire 

da un altro fondo e duplicandolo. 

Il fondo BSSU - LETTERE PROVA 2018 - NUOVA P. BOZZI è stato creato a partire dal registro GENERAL_LEDGER->BSSU 

- LETTERE PROVA SUM 2018->Aggiungi fondo. 

In entrambi i casi il periodo di validità del fondo è predeterminato. 

Compilare: Nome, Codice, Appartenente a (selezionare Università di Genova), Disponibile per (selezionare solo 

l’unità d’ordine che interessa e salvare). La casella Attiva può essere cliccata prima di salvare, in questo caso il fondo 

viene attivato e salvato 
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7.Per assegnare una somma a un fondo nella finestra Transazioni cliccare su Assegna fondi, quindi Aggiungi 

transazione accredito e Salvare 

 

8.Se si effettua una ricerca per fondi attivi 2018 e si filtra tramite le faccette, si vede che i fondi attivi sono ora 100, di 

cui 1 registro, 95 fondi accreditati (cioè veri e propri fondi dotati di somme allocate e transazioni), e 4 Fondi sommari 



11 

 

 

Se si clicca su Registro si visualizza il General Ledger per il 2018, comprensivo di tutte le somme allocate e tutte le 

transazioni per tutto il Sistema bibliotecario attribuite all’anno fiscale 2018.  

Editando il General Ledger si vede un grafico riepilogativo di impegni e spese, e spostandosi sulla finestra Fondi si 

vedono i fondi collegati al General Ledger 

 

 

Per aggiungere un fondo dalla finestra Fondi cliccare su Aggiungi fondo. Si presenta la scelta Fondo sommario/Fondo 

acrreditato. Se si seleziona Fondo sommario è possibile costituire un budget superiore che raccolga , p. esempio, 

tutti i fondi 2018 UMA, oppure tutti i fondi 2018 UMA periodici, oppure tutti i fondi UMA creati nel 2018 

9.Come avere anche bilanci riepilogativi cumulativi (summary funds) 

Posto che abbiamo scelto di avere un unico Ledger per anno fiscale, è possibile creare dei Summary funds (=Budget 

superiori) per ciascuna unità d’ordine, oppure per particolari tipologie di materiale.  Se si vuole seguire questa strada 

bisogna: 

-A partire dal General ledger aggiungere un nuovo fondo di tipo Summary fund. Il summary fund non avrà somme 
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assegnate, ma erediterà quelle dei suoi fondi. 

-a partire dal summary fund aggiungere un nuovo fondo, a cui assegnare le somme, imputare gli ordini, caricare le 

fatture 

In questo modo, partendo dal General Ledger 2018 abbiamo creato il summary fund  

BSSU - LETTERE PROVA SUM 2018  e l’abbiamo attivato, poi a partire da quest’ultimo abbiamo creato un fondo BSSU 

- LETTERE PROVA 2018 - NUOVA P. BOZZI, a cui abbiamo allocato la somma di 1.500 Euro 

 

Si potrebbe seguire questa strada, per esempio, per distinguere i fondi CREATI nel 2018 da quelli creati in 

precedenza, ma ancora validi nel 2018. 

10. Per eliminare un fondo creato per errore bisogna prima disattivarlo. Il fondo non deve avere transazioni 

attribuite (impegni, Fatture, accrediti … ). Eliminare tutte queste voci quindi disattivare il fondo dai … A questo 

punto cliccando sui puntini cliccare Elimina (Delete) 
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Ordine monografie 

 

A) Ricerca titolo da ordinare 

1. Quando si inizia una procedura di acquisizione conviene sempre posizionarsi sul dipartimento delle 

acquisizioni della propria scuola: in realtà l’ordine lo si può fare anche esternamente ma si arriva ad un 

punto in cui è necessario collocarsi nel dipartimento pena non riuscire più a vedere il flusso di lavoro della 

po-line creata 

2. Ricercare a catalogo il libro da ordinare con gli strumenti visti all’inizio. Se il libro non è presente bisogna 

prima creare un record bibliografico derivandolo o aprendo un template di catalogazione e catalogandolo ex 

novo. A tal fine è stato creato un template OrdineLibroPrint, percorso: Risorse->Apri editor metadata-

>Template->Unimarc bibliographic->Condiviso). Per creare un nuovo record di acquisizioni selezionare 

Nuovo: NB: prestare attenzione a NON modificare o eliminare il template 

 

 

3. Per ordinare il  volume, una volta visualizzato il titolo da acquistare, cliccare “Ordine” oppure sui puntini a 

destra … (Edita-Ordina-…) e selezionare “Ordine” nell’elenco delle azioni suggerite 
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Se invece si sta partendo da un record non presente, e quindi appena creato col template Acquisizioni, appena 

salvato il record cliccare sull’icona con il carrello per creare la linea PO 

 

B) Scelta tipo ordine e creazione linea PO: compilare i campi indicati qui sotto e creare la linea PO 

1- Sull’ordine scegliere il tipo ->Raccomandato. La maschera che si presenta è dinamica, a seconda del tipo di 

materiale. Per i titoli fisici selezionare “Fisico-Ordine singolo” 

2- In Proprietario Linea P.O. Scegliere l’Unità d’ordine 

3- Non selezionare Carica da template (no) 

4-Non selezionare Assegna inventario manualmente (Vuol dire “non creare automaticamente copia”)  

7-Cliccare su “Crea linea PO” 

8.Se compare un Warning di risorsa già presente, selezionare Conferma 
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C) Compilazione della maschera Linea d’ordine. Si apre la maschera linea d’ordine (PO line), aperta nella finestra 

“Sommario” 

1.Associare l’ordine alla library e alla location corrette, selezionando i … a fianco dell’Unità d’ordine e cliccando Edita 

2.Modificare Library e location. NB: la collocazione NON si mette qui, ma nella holding 

 
3. Cliccare su Salva. Compare un messaggio di creazione di una nuova holding, perché è stata cambiata la Library e la 

Location. Confermare 

4. Si ritorna alla maschera della linea d’ordine. Associare il fornitore. ATTENZIONE: E’ SEMPRE INDISPENSABILE 

ASSOCIARE IL FORNITORE PRIMA DI COMPILARE ALTRI DATI, ALTRIMENTI IL PROGRAMMA NON CARICA 

CORRETTAMENTE I DATI DI ATTESA PREVISTA DAL RECORD DEL FORNITORE E PARTONO SOLLECITI INCONGRUENTI 

 

5. Associare il fondo (cioè la COAN). Attenzione: cliccando su “Aggiungi Fondo +” si visualizzano solo i Fondi attivi e 

NON scaduti. Selezionare il fondo opportuno 

La maschera presenta già preimpostati il prezzo e la percentuale di addebito fondo 

 

6.Completare la maschera d’ordine selezionando: 

- il METODO DI ACQUISIZIONE: 

 -- ACQUISTO: in default che implica l’invio di una mail al fornitore 

 -- ACQUISTA DAL SISTEMA DEL FORNITORE (es Ebsco o Casalini….) 
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-Il tipo di materiale, il codice Report, e aggiungendo eventualmente una nota al fornitore.  

-la casella Creazione pacchetto manuale 

 

La casella “Creazione pacchetto manuale” va sempre selezionata, anche in caso di ordine singolo, perché solo in 

questo modo si ha la possibilità di selezionare la biblioteca di consegna materiale.  

L’ordine (PO) è attualmente impostato con Indirizzo di fatturazione della scuola e di spedizione sulla 1 biblioteca in 

ordine alfabetico (nel caso della BSSU è Sede di Lettere). Quindi se si vuole far arrivare il materiale nel posto giusto è 

obbligatorio Se invece l’Unità d’ordine che effettua l’ordine desidera che il materiale sia fornito all’indirizzo della 

Biblioteca di scuola e si tratta di un ordine singolo si può lasciare deselezionata casella. 

Anche in caso di acquisto dal sistema del fornitore, per cui non è necessario inserire l’indirizzo di spedizione da Alma 

è bene creare un pacchetto che permette una procedura manuale e non affidata ai job di Alma…. 

 

Completare la creazione dell’ordine selezionando: 

-SALVA E CONTINUA se vogliamo far arrivare la mail al fornitore con la segnalazione dell’indirizzo di spedizione 

(Metodo di acquisizione acquisto).  

-ORDINA ORA se il metodo di acquisizione è la piattaforma del fornitore. Il sistema crea e invia il buono d’ordine. 

E’ comunque possibile, anche in caso di acquisto sulla piattaforma del fornitore, selezionare Salva e continua e 

passare alla creazione del pacchetto manuale. Anche in questo caso non verrà inviata nessuna mail al fornitore 

 

D. Invio  buono  d’ordine comprendente una o più linee PO con creazione pacchetto manuale 

 

1. Creare una linea d’ordine come in precedenza. Selezionare durante la compilazione “Crea pacchetto 

manualmente”. Dare “Salva e continua” 

Compare un avviso di creazione della linea PO 

 
2. Aggiungere altre linee d’ordine 

3. Dal menu (blu) dei task V in alto a destra a fianco dell’identificativo operatore selezionare “Linee d’ordine-

Creazione pacchetto” 
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4.Selezionare i titoli che si vogliono ordinare e cliccare su “Crea nuovo PO” 

 

5. Compare il buono d’ordine creato, aperto in editing 

Nella sezione Biblioteca selezionare indirizzo di spedizione (cioè di consegna materiale) 

 
 

 

6.Per inviare il buono d’ordine cliccare “Salva e continua”. Se si esegue una nuova ricerca per numero riferimento 

PO: si vede che il buono d’ordine è stato inviato (status SENT) 
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NB: perché l’ordine sia effettivamente inviato il fornitore deve avere un valido indirizzo e-mail, altrimenti la linea 

d’ordine  rimane in status “Ready” e il PO appena creato  in status “In review” 

NB2: se al momento di concludere la creazione della linea d’ordine si è selezionato “Salva” invece che “Salva e 

continua” si dovranno rivedere gli ordini uno per uno prima di poterli inviare e, per ciascuno, sarà comunque 

necessario scegliere “Salva e continua”. Le linee d’ordine in questo status (revisione) saranno visualizzabili nel menu 

Task Ѵ Linee d’ordine – Revisione – Assegnate a te. Per ogni ordine sarà necessario usare l’opzione “Salva e 

continua”. 

7.Se vogliamo vedere cosa è successo al nostro ordine possiamo controllare cosa è arrivato al fornitore: 

Dalla barra blu selezioniamo Acquisizioni – Infrastrutture acquisizioni – Fornitori 

Cerchiamo il nostro fornitore e selezioniamo visualizza 

Tra le varie tab controlliamo gli allegati 

 

8. Se invece al momento dell’ordine abbiamo selezionato metodo di acquisizione  “Acquista dal sistema del 

fornitore”, la procedura è esattamente la stessa, ma in questo caso nessuna lettera verrà spedita al fornitore 

9. Eliminazione di un ordine: prima di eliminare un ordine eliminare le fatture collegate (vedi). 

Una volta eliminate le fatture, per eliminare un ordine occorre ricercare il titolo fisico ->cliccare sull’ordine->Dai 

puntini selezionare Annulla 



19 

 

 

 

 

Compare un avviso che la copia è stata comunque mantenuta Confermare 

 

 

Dal menu Acquisizioni->Elimina PO->inserire il numero di P.O da eliminare 

 

 

Cliccare su Monitora processi per verificare la cancellazione del pacchetto 

 

10. Eliminare una o più copie . Una volta eliminato l’ordine si devono eliminare le copie.  

Ricercare il titolo fisico->dai puntini->Copie->selezionare le copie da eliminare->Azioni->Cancella copie. 

Si presenta una richiesta di Lasciare la holding/Eliminare la holding. Selezionare l’azione voluta e conferma 
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11. Eliminare un titolo (che non abbia fatture, ordini, copie, holding collegati) 

Ricercare in Tutti i titoli il record da eliminare, aprirlo in editing Unimarc->File->Elimina record 

 

 

12. Eliminare un record inviato a SBN. Se il record non è condiviso anche da altre istituzioni SBN, quando si elimina il 

record dal catalogo validare la casella Elimina il record nel Catalogo Centrale. Il record sarà cancellato da Alma e da 

SBN. NB prima di questa operazione è necessario eliminare le localizzazioni SBN (vedi) 
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E) Ricezione (arrivo) dell’ordine) 

1. Dal menu Acquisizioni-Ricezione e fatturazione-selezionare Ricevi   

Mentre fino a questo punto era possibile agire senza selezionare una particolare unità d’ordine, se clicco su ricevi 

senza collocarmi non vedo nulla (ma per fortuna Alma avverte che non è stato selezionato nessun dipartimento) 

 

Se invece mi colloco nel mio SCUMA ACQUISITION DEPARTMENT allora…. 

 

 

2. Si presenta l’elenco delle linee d’ordine in status inviato (cioè le linee d’ordine in attesa di ricezione) e di quelle in 

attesa di fattura (cioè già ricevute, ma ancora da fatturare) 

Si può scorrere l’elenco, filtrarlo per fornitore, oppure inserire nella casella di ricerca “Ordine singolo” il numero 

della linea PO o altro criterio (titolo, ecc.) 

 3. Selezionare la linea d’ordine che interessa e cliccare su Ricevi in alto a destra. 

Attenzione: prima di dare Ricevi selezionare la casella “Tieni in dipartimento” Copy cataloguing per poter 

completare la catalogazione prima di porre il volume a scaffale.  

In caso avessimo dimenticato di selezionare la casella “Tieni in dipartimento” il libro ordinato risulterà in transito 

e non presente tra le copie del dipartimento.  In questo caso si può: 

- collegarsi al Banco di circolazione opportuno ed eseguire la scansione del barcode della copia, in modo che non 

risulti più in transito, quindi proseguire con il completamento della catalogazione e l’editing della copia 

-oppure, se non si intende procedere immediatamente, cercare la copia fisica, copiare il barcode, andare dal menu 

“Acquisizioni -> Processi post-ricezione -> scansione copie”, incollare il barcode nella finestra che si apre, e 

impostare lo stato a “Copy cataloguing”, per aver modo di completare la catalogazione prima che il volume venga 

richiesto a scaffale 
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Fatta la ricezione del POL-185, con  il flag “Tieni in dipartimento” il libro risulta in “Copy cataloguing” 

 

4.Se si cerca nuovamente il titolo fisico a catalogo si vede che: la copia ordinata, pur ricevuta, non è ancora 

disponibile  e ha una richiesta collegata. L’ordine è “in attesa di fattura” e lo step successivo è “copy cataloging” 

  

 

 

5.Per rendere disponibile la copia appena ricevuta dalla barra blu dei menu selezionare Acquisizioni – Processi post 

ricezione – Ricezione copie in dipartimento (oppure dall’elenco dei task selezionare: copie in dipartimento). Si 

presenta la lista di copie in attesa di essere lavorate prima di mandarle allo scaffale: scorrerla o ricercare il titolo che 

interessa 
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6.Sono possibili diverse azioni 

- Se clicco sul titolo e poi Edita posso editare il record bibliografico in caso avessi bisogno di aggiornare il record  

- Se clicco sui … Posso selezionare “edita copia inventario”, assegnare un diverso barcode, un numero di 

ingresso/inventario, e, soprattutto, cancellare il tipo di processo Acquisition technical services. Per farlo basta 

selezionare la barra bianca che si presenta come ultima riga dall’elenco a tendina. Questa operazione renderà il libro 

disponibile per l’utenza. 

 

 

A questo punto, dopo aver salvato, la copia è disponibile anche se non ha ancora la collocazione 
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7.Per aggiungere la collocazione cliccare su Holding ->Edita e inserire la collocazione desiderata, eventualmente 

modificando il tipo di collocazione. 

Posizionati sul campo 852 CTRL+F compilare il sottocampo $h. Se si desidera cambiare il tipo di collocazione (es. 

Dewey) inserire il codice 1 al posto di 8 come primo indicatore del campo 852 

 

 

Naturalmente sarebbe stato anche possibile digitare direttamente all’interno del campo, senza aprire il form. 

Salvare il record di holding prima di uscire (cliccare sull’icona col dischetto). A questo punto la copia è disponibile ed 

ha anche la collocazione 

NB: In caso sia necessario cambiare la location, per esempio la copia debba essere spostata da una location 

prestabile a una solo consultazione, è possibile farlo in questo contesto, sempre modificando la holding.  

8.Il processo Holding/edita copia può essere invertito 
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F) Fatturazione 

1. Dal menu Acquisizioni->Ricezione e fatturazione->selezionare Crea fattura 

2.Creare manualmente la fattura inserendo i dati (fornitore, importo fattura, data…). 

NB: non selezionare Gestisci ricezione. Al termine della compilazione selezionare Salva e crea linee di fattura 

 

 

Si presenta una schermata in cui è possibile eventualmente aggiungere spese di spedizione, sconti, costi generali. 

Normalmente lasciare invariata questa sezione 

 

 

3.Cliccando su Aggiungi riga fattura si apre la lista delle linee d’ordine in attesa di fattura per quel fornitore. 

Ricercare la linea d’ordine (o il titolo) che interessa, selezionarlo. Compilare i dati di fattura relativi alla linea 

d’ordine.  
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La linea di fattura si presenta già precompilata con i dati ricavati dalla linea d’ordine. E’ possibile modificare lo status 

da “Completamente fatturato” a “Parzialmente fatturato”, aggiungere un altro fondo per il pagamento o modificare 

il fondo, modificare l’importo della linea di fattura. Se ci sono più linee d’ordine nella fattura selezionare Aggiungi, 

altrimenti Aggiungi e chiudi.  

 

4.La fattura passa automaticamente nello status Wayting for payment. Cliccare nuovamente Salva e continua 

5.Si apre la lista delle fatture in attesa di pagamento (oppure, se lo si fa in un secondo tempo:. Dal menu 

Acquisizioni-Ricezione e fatture->selezionare In attesa di pagamento . 

Passare alla lista delle fatture Non assegnate 
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6. Andare in Edita fattura dai … 

Assegnare lo status "Pagato", la data, e compilare il campo "Numero del voucher" . Naturalmente questo campo può 

contenere il numero di mandato, oppure un numero fittizio. Cliccare Salva e continua 

 

A questo punto la fattura è pagata e l’ordine risulta chiuso, a meno che l’arrivo e la fattura non siano parziali 

 

7.NB: Al momento del pagamento la COAN deve essere attiva con validità nell’anno corrente. Se la scadenza è 

passata compare error. Prima di procedere al pagamento sincerarsi che le COAN (in Alma Fondi) siano attive e con 

validità corrente.  

Per aumentare la validità di un Fondo dal menu Acquisizioni->Infrastruttura acquisizioni->Fondi e registri, selezionare 

la COAN voluta, editarla e inserire un numero di giorni di validità oltre la data di scadenza nella sezione Regole-

>Tolleranza spese fine periodo fiscale, quindi  dare Salva 

8. Eliminare una fattura 

Ricercare la fattura, dai puntini … Revisiona->Vai a elenco attività->Elimina 
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Ordine Periodici cartacei 

A)Creazione dell’ordine 

1. Il flusso è lo stesso degli ordini monografie, ma selezionare tipo ordine “Fisico-Abbonamento”. 

Generalmente, se il LDR è impostato correttamente, il sistema sente che si tratta di una sottoscrizione e 

propone la scelta corretta. 

 2.Quando si clicca su Crea linea PO e si cerca di cambiare la Library e la Location però si apre direttamente la 

holding, perché prima di completare l’ordine è necessario: 

-modificare la Library e la Location 

- assegnare una collocazione 

- assegnare un Prediction pattern per quella holding e aprire i fascicoli dell’annata (ma questa operazione può essere 

fatta anche successivamente, ma comunque nello stesso giorno o nei giorni immediatamente successivi all’invio 

dell’ordine. Il pattern ben compilato è infatti necessario per la generazione automatica e corretta dei solleciti al 

fornitore) 

 

 

Apriamo il form ed effettuiamo le modifiche, Salviamo cliccando sull’icona del dischetto e diamo Esci 
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3.Tornare alla compilazione della linea d’ordine. Nella sezione Fornitore inserire il nome del fornitore. 

In questa sezione compaiono alcuni dati precompilati ereditati da quanto presente nel record fornitore: 

-Arrivo presunto dopo l’ordine 

-Periodo di tolleranza solleciti 

Il campo intervallo abbonamento, che compare precompilato con il dato di default 30 gg, indica il periodo di tempo 

previsto per la ricezione dopo la data di pubblicazione del fascicolo.  Questo dato può essere modificato: in base al 

dato inserito qui, verrà calcolata la data prevista di arrivo dei fascicoli creati con il  prediction pattern del periodico. 

La modifica non ha invece al momento effetto sulla data prevista di evasione dell’ordine. Si veda comunque la 

sezione Solleciti per una spiegazione più dettagliata delle differenze tra la data di attesa che viene calcolata nella 

linea d’ordine e la data prevista di arrivo di ciascun fascicolo.  

 

Compilare i campi rimanenti come per le monografie, ma selezionando questa volta Tipo di materiale Fascicolo e  

inserendo i dati di inizio e fine abbonamento, una data di rinnovo precedente alla scadenza, e un periodo di 

promemoria per il rinnovo. La data di rinnovo serve per la creazione dei rinnovi automatici, il numero di giorni di 

avviso precedenti la data di rinnovo serve per ricevere gli avvisi di prossima scadenza e per spostare la subscription 

da rinnovare nell’elenco dei task 

Ricordarsi di selezionare “Creazione pacchetto manuale”, quindi dare Salva e continua 
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4. La linea d’ordine è stata creata ed è in stato Creazione pacchetto manuale.  

Dal menu Task->selezionare Linee d’ordine->Creazione pacchetto 

Selezionare la linea d’ordine e cliccare su Crea nuovo PO 

5.Si apre il PO-6203(buono d’ordine creato) con status In review. E’ possibile editarlo per selezionare un indirizzo di 

spedizione. 

Cliccare su Salva e continua. L’ordine viene inviato 

6. L’ordine per un abbonamento è leggermente diverso dall’ordine per una monografia: lo status della PO line non è 

SENT, ma Wayting for renewal.NOTA BENE: se si sta effettuando un ordine di un abbonamento a un pacchetto o a un 

portfolio elettronico lo status della PO line è SENT fino a che la risorsa non viene attivata materialmente  

 

B)Creazione del prediction pattern e apertura dei fascicoli per l’anno in corso 

 

L’ordine e la holding per il periodico sono stati creati, ma non c’è ancora nessuna copia fisica disponibile 
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Per creare i fascicoli in attesa, e quindi procedere poi alla ricezione è necessario: 

- creare materialmente i singoli fascicoli aprendo il Prediction pattern 

1.Ricercare il titolo fisico e cliccare Holding-Edita 

2. Dal menu Edita selezionare Espandi da template. Selezionare il prediction pattern appropriato, per esempio 

“monthly regular” 

 

 

4.Nel record di holding compaiono 2 nuovi campi Marc21: 

-853, che contiene i dati di schedulazione da compilare 

-590, che contiene una nota relativa agli stessi dati 
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5.Se, posizionati sul campo 853, si usa il tasto F3 (oppure Tools->Marc21 holdings->Next predicted item info), si apre 

il form per la compilazione. Compilare opportunamente il form e dare Chiudi 

 

6.Dal menu Tools->Marc21 holdings->Open prediction pattern  

I fascicoli previsti vengono presentati, possiamo salvarli (in  questo modo vengono aperti), oppure cliccare su 

Cancella e correggere il campo 853 se qualcosa non è corretto 

 

Il sistema ha calcolato la data di arrivo prevista dei fascicoli in base alla data di pubblicazione del primo fascicolo 

01012018, a cui ha aggiunto 10 gg. di intervallo abbonamento. 

Trattandosi di un trimestrale ha calcolato la data di pubblicazione degli altri fascicoli, a cui ha aggiunto ugualmente 

10 gg. di intervallo abbonamento 

7.Prima di salvare la holding correggiamo la nota 590 

8.Se adesso ricerchiamo il titolo fisico in Alma –Fisico   vediamo che la colonna disponibilità copie è stata aggiornata 

con i dati della nostra nuova holding 

9.Se visualizziamo le copie connesse a questa holding vediamo che sono stati creati i 4 fascicoli con status “Non a 

scaffale” tipo processo “Acquisition”. 

NB: NON è possibile aprire i fascicoli di annate non comprese nell’ordine/sottoscrizione    
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Attenzione: può capitare che i fascicoli siano presentati con un ordine decrescente; in questo caso selezionare 

Routine di ordinamento ->Description e invertire l’ordine utilizzando le frecce a destra 

Appendice: Esempi di prediction pattern 

Generalmente i prediction pattern dei periodici vengono predisposti al momento dell’ordine per il periodico stesso. 

E’ tuttavia possibile che il responsabile dell’acquisizione demandi al catalogatore la compilazione del prediction 

patter, o che sia comunque necessario, durante il ciclo di vita del periodico, modificare la periodicità e quindi il 

prediction pattern. 

Facciamo un esempio per un periodico appena ordinato, ma per cui non è ancora stato creato un prediction pattern 

Se apriamo in editing il record di holding vediamo che è stata creata una holding di questo tipo 

 
 

Prima di creare il pattern correggiamo il LDR e indichiamo nella pos. 6 Tipo di record “y “ (holding copie periodico). 
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Per creare il pattern, posizionati sul campo 852, dal menu Edita->Espandi da template->selezioniamo il template 

appropriato, per esempio Quarterly 

months  

Vengono creati 2 nuovi campi, 853 che gestisce la schedulazione, e 590 che è una nota. 

 

Per impostare correttamente il pattern con i dati del prossimo fascicolo atteso, posizionati sul campo 853, dare F3 e 

compilare il form che si apre 
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Salvare e chiudere. Correggere anche opportunamente la nota 590 

Dal menu Strumenti ->Marc21 holdings->Apri copie previste 

 

Viene presentata l’anteprima dei fascicoli che verranno creati. Se è corretta, dare Salva 

 

Se torniamo ora a visualizzare le copie del periodico, vediamo che sono stati creati 4 nuovi fascicoli 

 

Editandone 1, ecco come sono stati compilati i dati di numerazione e le date 
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NOTA BENE: i prediction pattern per funzionare correttamente, cioè per creare fascicoli con numerazione e date 

corrette, devono avere compilati: 

-Primo livello numerazione = Volume ($$a): il primo volume atteso 

-Secondo livello di numerazione = Fascicolo ($$b): il primo fascicolo atteso 

-Primo livello cronologia = Anno ($$i): il primo anno atteso 

-Secondo livello cronologia = numero del mese o della stagione del primo fascicolo atteso ($$j): es. 01 per un 

mensile significa che il primo fascicolo atteso è di gennaio 

-Data fascicolo = data del primo fascicolo atteso (non data di arrivo previsto) 

 

In caso manchi, per esempio, la numerazione dei volumi si consiglia di procedere in questo modo: 

-inserire nel primo livello di numerazione l’anno 

 

Correggere poi il campo 853 indicando nel $$a a. (per anno), invece che v. (per volume). 

Correggere opportunamente anche la nota descrittiva 590 
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Se si aprono le copie previste si vede che vengono create queste copie: 

 

 

 

C)Arrivo dei fascicoli 

1.Dal menu Acquisizioni->Ricezione e fatturazione->Ricevi->Selezionare la lista “In continuazione”  e scorrere la lista 

o ricercare il titolo per cui si desidera registrare l’arrivo dei fascicoli 

 

2. Dai puntini …selezionare Gestisci copie. Si apre l’elenco dei fascicoli. 

Selezionare il fascicolo che si desidera ricevere e dare Salva e ricevi. Attenzione: Deselezionare la casella Tieni in 
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dipartimento. Se si desidera assegnare il numero di ingresso dai … Edita copia inventario 

 

Se adesso eseguiamo nuovamente una ricerca per titolo fisico vediamo che il fascicolo è arrivato ed è a scaffale 

 

 

D)Pagamento della fattura 

1.La fattura si crea come nelle monografie, prima si crea la fattura e poi si aggiungono le singole linee. 

Se in fattura ci sono dei carichi aggiuntivi (domiciliazione), questi vanno conteggiati nella casella importo totale.  

Costi aggiuntivi: indicare l’importo della domiciliazione. Cliccando su Usa pro rata i ricarichi vengono distribuiti su 

ciascuna linea d’ordine. 

Dare quindi Salva e continua 
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2.Aggiungi riga di fattura:  si presentano nuovi campi da compilare (verifica sovrapposizione date-range date di 

abbonamento). 

Da qui è anche possibile modificare il prezzo (per esempio per effetto dei cambi) e cambiare o aggiungere un 

ulteriore fondo di addebito, se per esempio fosse necessario separare le spese di domiciliazione dal prezzo del 

periodico.  

 Selezionare Rilascia impegno residuo in caso l’importo della linea di fattura sia inferiore all’importo della linea 

d’ordine. 

 

Quando si finisce di aggiungere l’ultima riga di fattura dare Salva e continua, la fattura è stata creata ed è in attesa di 

pagamento 

 

Possiamo vedere che il fondo di addebito ha contabilizzato un disimpegno per l’importo dell’ordine POL-259, e una 

nuova spesa per l’importo della fattura 
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2.Dal menu acquisizioni->Ricezione e Fatture->selezionare In attesa di pagamento. 

Editare la fattura e modificare lo status in Pagato, attribuire un numero di voucher ed, eventualmente, modificare la 

data del voucher. 

 

 

E)Solleciti 
I solleciti vengono inviati con procedura automatica in base a: 

- quanto indicato nella scheda fornitore 

- quanto indicato nella linea d’ordine 

- le date di attesa fascicoli create tramite il prediction pattern+l’intervallo abbonamento indicato nella linea d’ordine.  

Per gli ordini di monografie (one time physical) per calcolare la data di ricezione prevista viene aggiunto alla data 

dell’ordine il numero di giorni previsti per l’evasione dell’ordine (arrivo presunto dopo l’ordine) indicato nella linea 

d’ordine ed ereditato dal record del fornitore. Il sollecito viene generato e inviato automaticamente una volta 

scaduto il periodo di tolleranza solleciti (claiming grace period). 

 

Per gli ordini di periodici invece la data di ricezione prevista di ciascun fascicolo viene calcolata in base all’expected 

receiving date di ciascun fascicolo creato con il prediction pattern: data di pubblicazione del fascicolo+ numero di 

giorni definito nell’intervallo abbonamento. Il sollecito viene generato e inviato una volta scaduto il periodo di 

tolleranza solleciti, a cui deve essere aggiunto il periodo di tolleranza solleciti. 

NB: per i periodici c’è differenza tra la data di attesa indicata nella linea d’ordine e la data di attesa di ciascun 

fascicolo, calcolata come sopra. La data di attesa indicata nella linea d’ordine, che è dinamica, e si aggiorna man 

mano che si ricevono i fascicoli, viene presa in considerazione solo in caso il periodico NON sia gestito tramite il 

prediction pattern 

Si veda l’help on line di Alma e il documento Serials: Receiving and Claiming Appendix 1, alla URL 

https://www.dalnet.org/kb/alma/Appendix1%20to%20Instruction%20Serials%20ordering%20receiving%20claiming%2

0-%20OCC.docx 

The field 'subscription interval' has two purposes: 

1. In the order record it is always used to determine the “expected receipt date” as follows: 

a. “Expected receipt date” after sending the order but not yet checking in an issue will equal “sent 

date” + “Expected receipt after ordering (days)” 

b. “Expected receipt date” after checking in an issue will equal “Receive date of most recent issue” + 

“subscription interval” 

2. “Future” items will exist only if a prediction pattern is used.  In this case the expected arrival date of the issue 

(not the order) is the issue date (from 853 field of holding record prediction pattern) + “subscription interval” 

 

Expected receiving date - An item only has its own Expected receiving date if you are using prediction patterns. This 

field is set by the prediction pattern configuration. When there is a value for this field, the Expected receipt date of 

the PO line is ignored. Just like the Expected receipt date in the PO line, the PO line is sent to claims after the grace 

period elapses: Expected receipt date (of the item) + Claiming grace period (of the PO line). 

After the grace period, a claim is sent automatically to the vendor, either by EDI or by email, but only the first time 

this PO line is sent to the Claims page; if an operator updates the PO line's expected receipt date, and the PO line is 

sent to the Claims page again after the new date, another notification is not sent. 
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Per il momento contiamo di impostare tutti i fornitori con questi dati: 

-arrivo presunto dopo l’ordine: 15 

-periodo di tolleranza solleciti: 5 

 

G)RILEGATURA  

Alla fine dell’anno rilegare i fascicoli in annata 

Dalla lista delle copie di un periodico:  

-ricercare il titolo  e cliccare su holding 

 

 

Dai puntini a fianco della holding voluta selezionare Visualizza copie 

 

Selezionare le copie da rilegare e, dal pulsante Azioni, scegliere Rilega copie 
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Si apre la finestra di rilegatura->Avanti 

 

Nella seconda pagina selezionare Crea e Modifica senza indicare alcun ordine di lavoro 

 

Si apre un avviso di cancellazione dei fascicoli. Dare Conferma. Si apre la scheda di copia del volume. Completare  la 

compilazione di Numerazione A (numero volume), generare la descrizione (Genera), eventualmente aggiungendo il 

numero di inventario, quindi dare Salva. Eventuali fascicoli mancanti possono essere segnalati in nota. 

 

NB: con la rilegatura i singoli fascicoli spariscono. Eventuali note vanno riscritte. Il numero di inventario va attribuito 

al momento della rilegatura, non sul primo fascicolo. Si mantengono solo i dati dell’annata e il collegamento con 

l’ordine. 
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Appendice 1: Come associare una linea PO a una holding creata al di fuori del processo di creazione dell’ordine 

1.Ricercare il titolo ordinato. Visualizzare le holding cliccando sul pulsante Holding. Dal menu … selezionare Associa 

una linea PO 

 

 

Appendice 2: 

Ordini Ebsco e Casalini: per il momento inserirli sia sulla piattaforma del fornitore, sia a mano in Alma 

Fatture YBP Ebsco: stiamo caricando le fatture relative a ordini presenti in Aleph; per le fatture relative a ordini Alma 

sarà invece necessario per il momento inserirle manualmente. 

Appendice 3: 

Creazione ordini per più copie di un singolo volume o per più volumi di una monografia in più volumi 

1.Più copie dello stesso libro. 

Creare l’ordine come di consueto, ma, dopo aver modificato i dati relativi alla Biblioteca e alla location cliccare sul 

pulsante “Aggiungi localizzazione”, inserire il numero di copie  e la localizzazione voluta. Se la seconda copia ha lo 

stesso status di prestabilità selezionare la stessa location delle copie precedenti. 

 

Nella casella Quantità per prezzo indicare il numero totale di copie da ordinare, nel prezzo di listino indicare il prezzo 

della singola copia 
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Procedere quindi come per un ordine singolo. 

Al momento della ricezione, modificare la holding inserendo il dato di collocazione e modificare le copie inserendo i 

dati di copia (id copia, Descrizione), come spiegato nel manuale “Gestione risorse. Casi” 

 

2.Più volumi (1, 2, 3) di un’opera in più volumi descritta con record unico 

Ordinare come se si trattasse di un ordine singolo. Dopo aver modificato la localizzazione cliccare sul pulsante 

Aggiungi localizzazione e indicare SEMPRE la stessa del primo volume per i volumi 2, 3 ecc. In questo modo verrà 

creata una unica holding. 

 

Nel campo Quantità per prezzo indicare 1, nel prezzo di listino indicare il prezzo totale. Nella nota al fornitore 

indicare i volumi desiderati. 

 

Al momento della ricezione, modificare la holding inserendo il dato di collocazione e modificare le copie inserendo i 

dati di volume (Numerazione A, Descrizione), come spiegato nel manuale “Gestione risorse. Casi” 

 


